
Chapter 2

Working with Projects 
and Drawings

 Learning Objectives 
After completing this chapter, you will be able to:
• Create new projects and drawings
• Edit the properties of projects and drawings
• Add drawing descriptions
• Open existing projects
• Activate and close projects
• Add existing and new drawings to the current project
• Group the drawings of a project
• Rename, replace, and remove drawings from projects
• Assign a description to a drawing
• Open project drawings
• Copy existing projects
• Understand the working of the Project Manager
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Introduction
AutoCAD Electrical is a project-based software in which wiring diagrams related to each other 
are grouped under a project. A project is a set of electrical wiring diagrams that form a project 
file <project_name>.wdp. Each project is defined by an ASCII text file with .wdp extension. 
These project files contain a list of project information such as project settings, project or 
drawing properties, names and descriptions of drawing files, symbol library paths, and so on. 
You can have an unlimited number of projects. However, only one project can be active at a 
time. The list of these projects is displayed in the Project Manager.

Project Manager                                                                                                                              
 Ribbon:	 Project > Project Tools > Manager	  
 Toolbar:	 ACE:Main Electrical 2 > Project Manager	  
		  or ACE:Project > Project Manager	  
 Menu:		  Projects > Project > Project Manager	  
 Command:	 AEPROJECT	 			 

The Project Manager is used to create new projects, open existing projects, add new 
drawings to a project, re-order drawing files, access existing projects, and modify 
existing information in a project. By default, the Project Manager is opened and 

docked on the left of the  screen, as shown in Figure 2-1. If the Project Manager is not displayed 
by default, choose the Manager tool from the Project Tools panel of the Project tab; the 
Project Manager will be displayed. 

 

Figure 2-1  AutoCAD Electrical screen with the Project Manager 

Alternatively, choose the Project Manager tool from the ACE:Main Electrical 2 toolbar to 
display the Project Manager. The Project Manager is similar to other AutoCAD Electrical 
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tool palettes. You can dock the Project Manager at a specific location on the screen. Also, if 
you do not want to use the project tools, you can hide the Project Manager.  

When you double-click on the title bar of the Project Manager, it gets undocked and is displayed 
separately on the screen, as shown in Figure 2-2. When you right-click on the title bar of the 
undocked Project Manager, a shortcut menu is displayed, as shown in Figure 2-3. You can 
change the appearance, location, and display settings of the Project Manager by choosing the 
respective options from the shortcut menu.

Figure 2-2  The undocked Project 
Manager

Figure 2-3  The shortcut menu displayed on 
right-clicking on the title bar of the Project 
Manager 

When you double-click on a project name in the Projects rollout, a list of drawings associated 
with the project will be displayed. Also, the details of the selected project will be displayed in 
the Details rollout of the Project Manager, as shown in Figure 2-4. The name of the active 
project will appear in bold text in the Projects rollout of the Project Manager. 

When you right-click on a drawing name, a shortcut menu will be displayed. You can use the 
options in this shortcut menu to open, close, copy, remove, replace, rename, or access other 
editing options to modify the drawing file. These options are discussed in detail later in this 
chapter. You can open a drawing file by double-clicking on it and the corresponding drawing 
file will appear in bold text in the Projects rollout of the Project Manager.  
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Note
You cannot create two projects with the same name in the Project Manager. Moreover, using 
the Project Manager, you can switch between different projects and change their settings.

Opening a project 
You can open an existing project by using the Open Project button from the Project 
Manager. On doing so, the Select Project File dialog box will be displayed. Next, 
select the existing project from this dialog box and choose the Open button; the selected 

project’s name will automatically be displayed in the Projects rollout in bold text and it will 
become the active project.

Creating a new project 
 Command:	 ACENEWPROJECT 

You can create a new project by using the New 
Project button from the Project Manager. On 
doing so, the Create New Project dialog box will 

be displayed, as shown in Figure 2-5. Alternatively, use 
the ACENEWPROJECT command to create a new 
project. Different options in the Create New Project 
dialog box are discussed next.  
                                                                                            

Figure 2-4  The Project Manager 
displaying the Details rollout 

Name
The Name edit box is used to enter a name for the project. 
On doing so, the .wdp extension will automatically be 
added to the file name and displayed under the Create 
Folder with Project Name check box. 

Location
The Location edit box is used to specify the location 
for saving the project. You can also choose the Browse 
button on the right of the Location edit box to specify the 
location for saving the project file (.wdp file). By default, 
C:\Users\User Name\Documents\AcadE 2013\AeData\Proj\ is 
displayed in the Location edit box, refer to Figure 2-5.

Create Folder with Project Name
The Create Folder with Project Name check box is 
selected by default in this dialog box. As a result, a folder 
with a name identical to the project name will be created. 
Also, the new project will be saved in that folder. The path of the folder will be the same as 
that defined in the Location edit box. If you clear the Create Folder with Project Name check 
box, a separate folder will not be created for the project.    
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Copy Settings from Project File
You can also copy the settings from an existing project and apply it to a new project. To copy 
the settings from the existing project file, specify the name and location of the existing project 
file in the Copy Settings from Project File edit box. Alternatively, choose the Browse button 
on the right of this edit box; the Open dialog box will be displayed. Select an existing project 
file and then choose the Open button; the settings of the specified project will be applied to 
the new project and the location of the specified project will be displayed in the Copy Settings 
from Project File edit box. By default, C:\Users\User Name\Documents\AcadE 2013\AeData\Proj\
Demo\wddemo.wdp is displayed in the Copy Settings from Project File edit box.  

Figure 2-5   The Create New Project dialog box

Descriptions
The Descriptions button is used to add a description to the project. Choose the 
Descriptions button; the Project Description dialog box will be displayed, as shown in 
Figure 2-6. In this dialog box, you can enter a description of the new project up to 12 lines per 
page. If you want to include the description in the reports, select the in reports check box on 
the right of each description line. Note that the descriptions thus added will be included in 
the report headers of the report file and the title blocks of the drawing. Now, choose the OK 
button from this dialog box to save the changes made and exit the dialog box. The concept 
of report generation, title blocks, and Project Description dialog box are discussed in detail 
in the later chapters.

OK 
The OK button of the Create New Project dialog box will be activated only if you enter the 
name of the project in the Name edit box. Choose the OK button; the project that you created 
will be added to the current project lists in the Project Manager. Also, it will become an active 
project and its name will appear in bold text in the Project Manager.
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OK-Properties
The OK-Properties button will be activated only if you enter the project name in the Name 
edit box. Choose the OK-Properties button; a new project will be created and the Project 
Properties dialog box will be displayed. This dialog box is used to modify project settings, 
components, wire numbering, cross-references, styles, and drawing formats. All information 
defined in the Project Properties dialog box are saved to the project definition file (.wdp) as 
project and drawing defaults. Next, choose the OK button from this dialog box to exit from 
it. The options in the Project Properties dialog box are discussed later. 

Figure 2-6  The Project Description dialog box

Note
You can also create a new project by right-clicking inside the Projects rollout and then choosing 
the New Project option from the shortcut menu displayed or by selecting the New Project option 
from the Project selection drop-down list in the Project Manager. You will learn more about 
it later in this chapter.

WORking with drawings
In the previous topic, you learned to create new projects using the Project Manager. Now, 
you will learn how to create new drawings within an active project.

You can add any number of drawings to your project at any time. A project file can have 
drawings located in different directories. But, it is recommended that you save your drawings 
and project file (.wdp) in the same folder. When you create a new drawing, an invisible smart 
block, WD_M, will automatically be added to your drawing at location 0,0. The WD_M block 
defines drawing settings. These settings may be different from the project settings. Thus, you 
can have different settings for different drawings in a single project. Also, each AutoCAD 
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Electrical drawing should contain only one copy of invisible WD_M block. If multiple WD_M 
blocks are present in the drawing, the settings may not be stored and read consistently. Also, 
note that the drawing to be created will automatically get added to the active project. 

Creating a New Drawing
 Command:	 ACENEWDRAWING 

The New Drawing button is used to create a new drawing file. To do so, choose the New 
Drawing button from the Project Manager; the Create New Drawing dialog box will 
be displayed, as shown in Figure 2-7.

Figure 2-7  The Create New Drawing dialog box

Alternatively, invoke this dialog box by using the ACENEWDRAWING command or by 
right-clicking on the Projects rollout of the Project Manager and then choosing the New 
Drawing option from the shortcut menu displayed. The different areas and options in this 
dialog box are discussed next. 
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Drawing File Area
The options in the Drawing File area are used to specify the name of a drawing file, the 
template file to be used in the drawing, the location to save the drawing, and the description 
for the new drawing file. The options in this area are discussed next.

Name
Enter a name for the new drawing in the Name edit box; the .dwg extension will automatically 
be added to the drawing name. Note that the OK and OK - Properties buttons will be 
activated only after entering the name of the new drawing in this edit box. 

Template
This edit box is used to specify the path and name of  a template drawing (.dwt) for creating 
drawing file. Alternatively, you can choose the Browse button; the Select template dialog 
box will be displayed. Select the template drawing from this dialog box and choose the 
Open button; the location of the template drawing will be displayed in the Template 
edit box. 
 

Note
After specifying the template in the Template edit box, next time when you create a new drawing, 
the template entered previously will automatically get displayed in the Template edit box. If this 
edit box is left blank, AutoCAD Electrical will use the default acad.dwt file. 

For Reference Only 
The reference drawings are used for coversheets, terminal plans, and other non-electrical 
layouts in a project. These drawings save the processing time of AutoCAD Electrical 
functions. To create a reference drawing, you need to select the For Reference Only check 
box. On doing so, the reference drawing will be included in the project-wide plotting and 
title block update operations. All other electrical smart functions such as cross-referencing, 
automatic tagging, reporting, and so on will be non-functional. By default, the For 
Reference Only check box is cleared.  

Note
The color of the reference drawing icon displayed on the left of the drawing name in the Project 
Manager is gray.

Location 
The Location edit box is used to specify the location of a new drawing. The directory of 
the active project file is specified by default in the Location edit box. Alternatively, choose 
the Browse button on its right for specifying a different location for the new drawing. 
If you leave the Location edit box blank, the drawing file will be created at the same 
location as that of the active project. Note that you cannot create duplicate drawings at 
the same location.       

Description 1-3
The Description 1, Description 2, and Description 3 edit boxes are used to enter 
description for a drawing. In these edit boxes, you can enter up to 3 description lines for 
a drawing file. You can also specify the description for a drawing by selecting it from the 
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description drop-down lists. But this is possible only if you have entered description in the 
earlier drawings. The description thus entered will be displayed in the title block updates 
and custom drawing properties.

OK 
The OK button will be activated only if you enter a drawing file name in the Name edit box. 
When you choose the OK button, the new drawing gets automatically added at the bottom of 
the list in the active project and it appears in bold text. To view the drawing file, expand the 
active project by double-clicking on the project name.

OK - Properties
The OK - Properties button will be activated only if you enter a drawing name in the Name 
edit box of the Drawing File area. Choose the OK - Properties button; a drawing file will be 
created at the specified location and also the Drawing Properties dialog box will be displayed, 
as shown in Figure 2-8. 

Figure 2-8  The Drawing Properties dialog box
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                                                                                                                                This dialog box is used to define settings and options for a drawing. The options in the 
Drawing Properties dialog box will be discussed in the later chapters. The changes that you 
make using this dialog box will be saved as attribute values on the drawing’s invisible WD_M 
block. Choose the OK button from the Drawing Properties dialog box; the drawing will be 
created and will appear in bold text at the bottom of the project list of the active project in 
the Project Manager.

Note
Mentioning information in the Description edit boxes, the IEC-Style Designators area, the 
Sheet values area, as well as choosing the OK-Properties button is optional. You can also edit 
any of these fields later in the Drawing Properties dialog box.

Tip: The IEC style designators are widely used when you are using the IEC drafting standard. 
You must be aware of the drafting standards used in AutoCAD Electrical. The software has 
been designed to use five International Drafting Standards which are listed below:

1. Joint Industrial Council ---- JIC (USA)
2. International Electrotechnical Commission ---- IEC (Europe, UK)
3. Japanese International Standard ---- JIS (Japan)
4. Guobiao Standard ---- GB (Chinese)
5. Australian Standard ---- AS (Australia)               

Adding a New Drawing to the Current Project
You can add a new drawing to the current project using the Project Manager. If the Project 
Manager is not displayed by default on your screen, then choose the Manager tool from 
the Project Tools panel of the Project tab or choose the Project Manager tool from the 
ACE: Main Electrical 2 or ACE:Project toolbar; the Project Manager will be displayed on 
the left of the screen, refer to Figure 2-1. Next, choose the New Drawing button from the 
Project Manager; the Create New Drawing dialog box will be displayed. Enter the required  
information in this dialog box, as explained earlier and then choose the OK button; a new 
drawing will be created. Also, this drawing will automatically be added to the active project 
and will appear in bold text at the end of the Project Drawing list. Next, to add this drawing 
to an inactive project, right-click on the inactive project name and choose the Add Active 
Drawing option from the shortcut menu displayed; the Apply Project Defaults to Drawing 
Settings message box will be displayed, as shown in Figure 2-9. 

                

Figure 2-9  The Apply Project Defaults to Drawing Settings message box
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Choose the Yes button from the Apply Project Defaults to Drawing Settings message box; 
the default values of the project will be added to the WD_M block definition of the newly 
added drawing. If you choose the No button, the new drawing will retain its existing settings. 
Choose the Cancel button to exit the command. 

Note
You can have a single drawing in multiple projects. 
 

Adding Existing Drawings to the Current Project
You can also add the existing drawings to the 
current projects. To do so, right-click on the 
project name in the Projects rollout of the Project 
Manager; a shortcut menu will be displayed, as 
shown in Figure 2-10. Choose the Add Drawings 
option from the shortcut menu; the Select Files 
to Add dialog box will be displayed, as shown in 
Figure 2-11. Select the drawings to be added to 
the project from this dialog box. Choose the Add 
button; the Apply Project Defaults to Drawing 
Settings message box will be displayed, refer to 
Figure 2-9. 

Figure 2-10  The shortcut menu displayed 
on right-clicking on the active project name 
in the Project Manager

If you choose the Yes button, the default values 
of the project will be added to the WD_M block 
definition of the newly added drawing. But if you 
choose the No button, the new drawing will retain 
its existing settings. Also, the selected drawings 
will be added to your project and will appear at 
the end of the Project Drawing list. 

Note
You can select multiple drawing files at a time from the Select Files to Add dialog box by pressing 
the SHIFT or CTRL key. 

working with project drawings
You can group drawings, remove drawings, assign description to drawings, preview drawings, 
configure the drawing list display, and so on by using the Project Manager. Also, you can access 
the existing project and modify its related information using the Project Manager.
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Figure 2-11  The Select Files to Add dialog box

Grouping Drawings within a Project
You can group the drawings in a project in two ways: grouping using section/subsection and 
grouping using subfolders. These are discussed next.

Grouping Drawings Using Section/Subsection 
You can create a group of drawings within a project list by assigning the section and sub-section 
codes to each drawing. To do so, expand the project by double-clicking on its name, if it is 
not already expanded; the drawings in that project will be displayed. Next, right-click on the 
drawing file; a shortcut menu will be displayed. Choose Properties > Drawing Properties from 
the shortcut menu; the Drawing Properties dialog box will be displayed, refer to Figure 2-8. In 
this dialog box, the Drawing Settings tab is chosen by default. Enter the required section and 
sub-section codes for the drawing in the Sheet Values area and choose the OK button; the 
section and sub-section codes will get assigned to the drawing file. Similarly, you can repeat 
the same procedure for each drawing that you want to group together, but ensure that the 
same section and sub-section codes are assigned to all of them.   

Grouping Drawings Using Subfolders
In AutoCAD Electrical 2013, you can create subfolders within a project to organise the 
drawings. To create a subfolder, right-click on the project; a shortcut menu will be displayed. 
Choose Add Subfolder from it; a subfolder with the name NEW FOLDER will be created at 
the bottom of the drawing list. Rename it with a suitable name. Now, you can drag and drop 
the drawings available in the project into the subfolder. When you right-click on the subfolder; 
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a shortcut menu will be displayed. The options in the shortcut menu are used to create and 
add drawings, rename the subfolder, and so on. You can add any number of subfolders in a 
project. Also, you can add subfolders within a subfolder.

You can also remove all the subfolders from an active project. To do so, right-click on an active 
project and choose Flatten Structure from the shortcut menu displayed; a Flatten Project 
Structure message box will be displayed warning you that if proceeded, you will not be able to 
revert back the changes again. Note that when you use this option only subfolders are removed 
and the drawings are retained in the project.
       
After creating a group of drawings and subfolders, the project-wide tagging, cross-referencing, 
and reporting functions can be performed on the whole project or a part of the drawing set, 
using the section, sub-section coding, and subfolders.

Changing the Order of Drawings in a Project
In the Project Drawing list, the drawings created are arranged in the same sequence 
as they are processed by AutoCAD Electrical during the project-wide tagging and 
cross-referencing operations. However, you can change the order of the drawings present in 
a project by dragging and dropping the drawings at the required place in a sequence. You can 
also reorder the drawings by moving them between two subfolders of a project. Note that you 
cannot reorder the drawings by moving them between two projects. You can press the CTRL 
or SHIFT key to select multiple drawings. 

You can also sort the drawings in a project to change their order. To do so, right-click on the 
project name and choose the Sort option from the shortcut menu displayed. If the project 
contains subfolder(s), the Sort Options message box will be displayed showing four different 
combinations of options to sort the drawings in the project folder and its subfolder(s), refer 
to Figure 2-12. Choose one of these options as per your requirement; the Sort Fields dialog 
box will be displayed, as shown in Figure 2-13.   

Figure 2-12  The Sort Options message box

You can sort out the drawings in different ways depending upon the options selected from the 
Sort Fields dialog box. You can select the required option from the Primary sort, Secondary 



2-14                                                       AutoCAD Electrical for Electrical Control Designers 
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

sort, Third sort, and Fourth sort drop-down lists. These drop-down lists include REF (reference 
status), SEC (section code), SUBSEC (sub-section), and FILEPATHANDNAME (file path and 
name) options, respectively. 
   
Some projects do not contain subfolder(s). If you right-click on such a project and choose the 
Sort option from the shortcut menu displayed; the Sort Fields dialog box will be displayed, 
refer to Figure 2-13. 

Figure 2-13  The Sort Fields dialog box

After setting the required parameters, choose the OK button from the Sort Fields dialog box; 
the drawing displayed in the list will be arranged according to the options selected from the 
drop-down lists. Next, choose the OK button in the Sort Fields dialog box to save the changes 
and exit the dialog box.  

Removing a Drawing from a Project
You can remove a drawing from a project using two methods. These methods are discussed 
next.
 
First Method
Right-click on the drawing name in the Project Manager; a shortcut menu will be displayed. 
Choose the Remove option from the shortcut menu; the Project Manager - Remove Files 
message box will be displayed. Choose the Yes button from the message box; the drawing will 
be removed from the project, but it will not be deleted from the folder where it is stored. 

Second Method
Right-click on a project name; a shortcut menu will be displayed. Next, choose the Remove 
Drawings option from the shortcut menu; the Select Drawings to Process dialog box will be 
displayed, as shown in Figure 2-14. The options in this dialog box are discussed next.

Drawing
The Drawing radio button is used to display the path and the name of all drawings in a 
project. This radio button is selected by default.  

Description
	 Select the Description radio button; the description of all drawings will be displayed in the 

top list of the Select Drawings to Process dialog box. Remember that the description will 
be displayed only if you have entered the description in the Description 1/2/3 edit boxes 
in the Create New Drawing dialog box or in the Description 1/2/3 edit boxes of the 
Drawing Settings tab in the Drawing Properties dialog box. 
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Figure 2-14  The Select Drawings to Process dialog box

Do All
Choose the Do All button to transfer all drawings from the top list to the bottom list of 
the Select Drawings to Process dialog box. 

Process 
The Process button will be activated only if you select a drawing(s) from the top list. This 
button is used to transfer the selected drawing from the top list to the bottom list. To do 
so, select a drawing(s) and then choose the Process  button; the selected drawing(s) will be 
transferred from the top list to the bottom list of the Select Drawings to Process dialog 
box. You can use the SHIFT or CTRL key to select more than one drawing at a time.

Reset
The Reset button will be activated only if you have transferred drawing(s) from the top 
list to the bottom list. Choose the Reset button to reset the drawings to their original 
positions in the dialog box. 

Un-select
The Un-select button will be activated only if you select drawing(s) from the bottom list. 
The Un-select button is used to transfer drawing from the bottom list to the top list. To 
do so, select a drawing(s) from the bottom list and then choose the Un-select button; 
the drawings will be moved from the bottom list to the top list. You can unselect multiple 
drawings at a time by using the SHIFT or CTRL key.
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by Section/sub-section 
The by Section/sub-section button is used to select the drawings that have been grouped 
by specifying their sections and sub-sections. To do so, choose the by Section/Sub-section 
button from the Select Drawings to Process dialog box; the Select Drawings by 
Section/sub-section dialog box will be displayed. Specify the section and sub-section codes 
in the Section and Sub-section edit boxes, respectively. Alternatively, select the section and 
sub-section codes from the Section and Sub-section drop-down lists, respectively. Next, 
choose the OK button from the Select Drawings by Section/sub-section dialog box; the 
corresponding drawing(s) will be transferred from the top list to the bottom list. Note 
that the Section and Sub-section drop-down lists display the section and sub-section 
codes only if you have entered the section and sub-section values in the Sheet Values area 
of the Create New Drawing dialog box or in the Drawing Settings tab of the Drawing 
Properties dialog box.

by Subfolder
	 The by Subfolder button is used to select the drawings that have been grouped in 

subfolders. To do so, choose the by Subfolder button from the Select Drawings to Process 
dialog box; the Select Drawings by Subfolder dialog box will be displayed. Select the 
subfolder(s) from this dialog box and choose the OK button; the drawings from the 
selected subfolder(s) will be transferred from the top list to the bottom list. Note that the 
Select Drawings by Subfolder dialog box displays the subfolders only if you have added 
subfolders in the project.

After selecting drawings from the Select Drawings to Process dialog box, choose the OK 
button; the Remove Drawing(s) from Project List message box will be displayed. In this 
message box, choose the OK button; the selected drawings  will be removed from the project 
list. Note that the drawings will instantly be removed from the project list, but they will not 
be deleted permanently from the folder where they are stored.

Assigning a Description to a Drawing
You can assign a three-line description to each drawing listed in your project. To do so, 
right-click on the name of a drawing in the project; a shortcut menu will be displayed. 
Next, choose Properties > Drawing Properties from the shortcut menu; the Drawing 
Properties dialog box will be displayed. 

By default, the Drawing Settings tab is chosen in the Drawing Properties dialog box. Enter 
a description for the drawing in the Description 1/2/3 edit boxes. You can also select the 
predefined description for your drawing from the Description drop-down list. Note that 
the predefined description will be available only if you have entered the description for 
any of the drawings of a project, as shown in Figure 2-15. This figure shows the predefined 
descriptions listed in the Description 1 drop-down list of the Drawing Properties dialog 
box. Next, choose the OK button; the drawing file will be updated and the changes will be 
saved. 
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Figure 2-15  Partial view of the Drawing Properties dialog box 
displaying predefined description

Note
The description specified in the Description 1, Description 2, and Description 3 edit boxes 
of the Create New Drawing or Drawing Properties dialog box can be linked to the attribute 
in the title block for automatic update and will be discussed in the later chapters.

After adding description to a drawing, you can preview the description in the Details rollout 
of the Project Manager. These drawing details give a unique identity to the drawings based 
on users requirement and helps the users to search a particular drawing among multiple 
drawings in a project file.

Switching between the Drawings of an Active Project
 Ribbon:	 Project > Other Tools > Previous DWG 		   
 	  	 Project > Other Tools > Next DWG		   
 Toolbar:	 ACE:Main Electrical 2 > Previous Project Drawing	  
 		  ACE:Main Electrical 2 > Next Project Drawing	  
 		  ACE:Quick Pick > Previous Project Drawing	  
 	  	 ACE:Quick Pick > Next Project Drawing		   
 Command: 	 AEPREV and AENEXT				  

The Previous DWG and Next DWG tools are used to open the previous and next 
drawings of an active project. Using these tools, you can view and switch between 
various drawings of a project. To do so, open any drawing of the active project 

and then choose the Previous DWG or Next DWG tool from the Other Tools panel of the 
Project tab. Alternatively, you can choose the Previous Project Drawing or Next Project 
Drawing tool from the ACE:Main Electrical 2 or ACE:Quick Pick toolbar. On doing so, the 
currently opened drawing will be closed and all changes made to it will be saved. Also, the 
requested drawing will open. The currently opened drawing will appear in bold text in the 
project list.     
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Tip: To open all drawings of an active project in a new window without closing the original 
drawing window, hold the SHIFT key while choosing the Previous Project Drawing or 
Next Project Drawing button.  

Note 
You cannot view and switch among the drawings that are not associated with the active project.You 
can use the Project Manager to preview the drawings easily. If you move among various 
drawings using the up and down arrow keys, the selected drawing will not open. 

Configuring the Drawing List Display
The Drawing List Display Configuration 
button is used to configure the information 
related to various drawings in the Projects 

rollout of the Project Manager. This button is used 
to display the required information such as drawing 
number, description, and so  on. By default, only the 
name of the drawing is displayed in the Projects 
rollout of the Project Manager, as shown in 
Figure 2-16. Choose the Drawing List Display 
Configuration button from the Project Manager; 
the Drawing List Display Configuration dialog box 
will be displayed, as shown in Figure 2-17. The op-
tions in this dialog box are discussed next.

Figure 2-16  Partial view of the 
Project Manager displaying the drawing 
files of the project

Display Options Area
The Display Options area displays the predefined 
values that can be associated to a drawing. 
  

Figure 2-17  The Drawing List Display Configuration dialog box
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Current Display Order
The Current Display Order area lists the order in which the required display options will be 
displayed in the Projects rollout in the Project Manager. The File Name option is displayed 
by default in this area. You can add other display options in this area by selecting them from 
the Display Options area and then choose >> button. 

>>
The >> button is used to move only the selected display option from the Display Options 
area to the Current Display Order area.

All>>                   
The All>> button is used to move all display options from the Display Options area to the 
Current Display Order area.

<<
The << button is used to move only the selected display option from the Current Display 
Order area to the Display Options area. 

<<All
The <<All button is used to move all display options from the Current Display Order area 
to the Display Options area.  

Separator Value
The Separator Value edit box is used to specify the character to be used as a separator 
between the values in the listing. You can enter a character in the Separator Value edit box 
or use the default character (-) in this edit box. 

Move Up
Choose the Move Up button to move the selected 
display option one step up in the Current Display 
Order area. 

Move Down
Choose the Move Down button to move the selected 
display option one step down in the Current Display 
Order area. 

Choose the OK button in the Drawing List Display 
Configuration dialog box; the entire information 
related to drawings will be displayed in the Projects 
rollout, refer to Figure 2-18.  

Figure 2-18  Partial view of the Project 
Manager displaying the drawing 
information
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Note
The sequence in which the drawing options are displayed in the Current Display Order area, 
the same sequence is followed for their display in the Projects rollout of the Project Manager. 
If you want to change the sequence, choose the Move Up or Move Down button. 

COPYING A PROJECT
  Ribbon:	 Project > Project Tools > Copy						       
  Toolbar:	 ACE:Main Electrical 2 > Project Manager drop-down > Copy Project  	  
		  or ACE:Project > Copy Project						       
  Menu:		 Projects > Project > Copy Project					      
  Command:	 AECOPYPROJECT							     

The Copy tool is used to copy the entire project as well as copy the drawings present 
within that project. To do so, choose the Copy tool from the Project Tools panel of 
the Project tab; the Copy Project: Step 1 - Select Existing Project to Copy wizard 

will be displayed, as shown in Figure 2-19.

Figure 2-19  The Copy Project: Step 1 - Select Existing Project to Copy wizard

Note
Before copying drawings to a new project, you need to close all drawings of that project.

Next, enter the name and path of the existing project in the Enter existing project name 
edit box. Alternatively, choose the Browse button from this dialog box to select the existing 
project; the Select existing project to copy dialog box will be displayed. Next, double-click 
on the project folder that you want to copy. Select the project’s .wdp file and choose the Open 
button; the name and path of the existing project will be displayed in the Enter existing project 
name edit box. You can also choose the Copy Active Project button available in this dialog 
box to copy the currently active project.  

Choose the OK button; the Copy Project: Step 2 - Select path and name for new project 
wizard will be displayed, as shown in Figure 2-20. Enter a name for the new project in the 
File name edit box and select the path for the new project from the Save in drop-down list. 
By default, the .wdp extension will be displayed in the Save as type edit box. Next, choose 
the Save button; the Select Drawings to Process dialog box will be displayed, as shown in 
Figure 2-21. 
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Figure 2-20  The Copy Project: Step 2 - Select path and name for new project wizard

   

Figure 2-21  The Select Drawings to Process dialog box

Select the drawing files that you want to copy in the project from the top list of this dialog 
box. Next, choose the Process button; the selected drawings will be transferred from the top 
list of the Select Drawings to Process dialog box to the bottom list. The other options in the 
Select Drawings to Process dialog box have already been discussed. Choose the OK button 
from the Select Drawings to Process dialog box; the Copy Project: Step 4 -- Enter Base Path 
for Project Drawings wizard will be displayed, as shown in Figure 2-22.
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Figure 2-22  The Copy Project: Step 4 -- Enter Base Path for Project Drawings wizard

Note
In case, there is no drawing file in the project to be copied, then the Select Drawings to Process 
dialog box will not be displayed and the AutoCAD Message message box will be displayed. 
Choose the OK button in this message box; the Copy Project: Step 4 -- Enter Base Path for 
Project Drawings wizard will be displayed.  

In this dialog box, enter the directory path where the new project will be saved. The 
directory path will be created, if it does not exist. In the Select Project-Related Files to be 
Copied area, you can specify the project related files that need to be copied to the project 
that you want to create. Note that the project related files to be copied will be activated in the 
Select Project-Related Files to be Copied area. To copy these files, select the check boxes 
on the left of the respective files and then choose the OK button; the Copy Project: Step 5 
-- Adjust new drawing file names wizard will be displayed, as shown in Figure 2-23. 

Figure 2-23  The Copy Project: Step 5 -- Adjust new drawing file names wizard
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Choose the Edit button in this wizard to edit the file name and path of the selected drawing, 
if needed. Similarly, choose the Find/Replace button to find or replace a drawing file name 
and its path. Next, choose the OK button; the name of the new project will be displayed at 
the top in the Projects rollout in bold text and will become the active project.

Deleting a project
 Ribbon:	 Project > Project Tools> Delete  		  
 Menu:	 	 Projects > Project > Delete Project  	  
 Command:	 AEDELETEPROJECT			 

 The Delete button or the AEDELETEPROJECT command is used to delete an 
existing project and its drawings, permanently. To do so, choose the Delete button 
from the Project Tools panel of the Project tab; the Select Existing Project to Delete 

dialog box will be displayed, as shown in Figure 2-24. 

                      

Figure 2-24  The Select Existing Project to Delete dialog box

                     

Enter the name of the project file to be deleted in the File name edit box. Alternatively, select 
a project name from the list displayed in the Select Existing Project to Delete dialog box. 
Next, double-click on the name of the project folder, if it exists. Select the project definition 
file(.wdp) and choose the Open button; the Project File Delete Utility dialog box will be 
displayed, as shown in Figure 2-25. The options in this dialog box are discussed next.

Delete “.wdp” project list file
The Delete “.wdp” project list file check box is used to permanently delete the selected 
project file with .wdp extension. 
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Delete project’s AutoCAD drawing files
The Delete project’s AutoCAD 
drawing files check box is used to 
delete only the drawing files of a 
project. Note that this check box will 
be activated only if the related project 
consists of drawing files.

Figure 2-25  The Project File Delete Utility dialog box

List
The List button will be activated 
only if you select the Delete project’s 
AutoCAD drawing files check box. 
Choose the List button; the Select 
Drawings to Process dialog box will 
be displayed, refer to Figure 2-21. 
Select the drawings to be deleted from 
the drawing file list of the project. Next, choose the OK button from the Select Drawings to 
Process dialog box; the Project File Delete Utility dialog box will be displayed again. Choose 
the Delete Files button from the Project File Delete Utility dialog box; the selected files will 
be deleted permanently, and you cannot retrieve them.

other options in the project manager
As discussed earlier, the Project Manager lists the drawing files associated with each project. 
You can change the settings of a project by using the Project Manager, refer to Figure 2-26. 
The major tools and rollouts in the Project Manager have already been discussed. Some of 
the remaining ones are discussed next.

1.	 Buttons
2. 	 Project selection drop-down list
3. 	 Projects rollout
4. 	 Project Drawing list
5. 	 Detail/Preview rollout

Buttons
There are several buttons available in the Project Manager such as Refresh, Publish/Plot, 
and so on, see Figure 2-27. These buttons are discussed next. 
         
Refresh

The Refresh button is used to freshen the drawing list present in the Project 
Manager. 
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Figure 2-26  Various components of the Project Manager

Figure 2-27  Various buttons in the Project Manager 

Project Task List
 Command:	 C:WD_UPD_PENDING NIL 

The Project Task List button will be activated only if there are pending updates for 
a drawing file. The Project Task List button is used to execute the pending updates 
on any drawing files modified in the active project. Choose the Project Task List 

button from the Project Manager or right-click on the active project; a shortcut menu will be 
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displayed. Next, choose the Task List option from the shortcut menu; the Task List dialog 
box will be displayed. Select the drawing files that you want to update and choose the OK 
button; the QSAVE message box will be displayed. Choose the OK button from the QSAVE 
message box; the drawing(s) will be updated. The options in the Task List dialog box are 
discussed in detail in Chapter 12.

Project-Wide Update/Retag
 Command:	 C:WD_BUMP 

The Project-Wide Update Retag button is used to update the related line 
reference numbers, device tagging, cross-reference text, and signal reference updates on 
the selected drawing files in an active project. Choose the Project-Wide Update/Retag 

button from the Project Manager; the Project-Wide Update or Retag dialog box will be 
displayed. Specify the required options in this dialog box and choose the OK button; the 
Select Drawings to Process dialog box will be displayed. Now, select the drawings that you 
want to process and choose the Process button. Next, choose the OK button; the selected 
drawings will be updated. The options in the Project-Wide Update or Retag dialog box will 
be discussed in detail in Chapter 6. You can also use the (C:WD_BUMP) command to invoke 
the Project-Wide Update or Retag dialog box. 

Publish / Plot 
Choose the Publish / Plot button from the 
Project Manager; the Publish/Plot drop-down 
will be displayed, as shown in Figure 2-28. The 

options in the drop-down of the Publish / Plot button 
are used to plot active drawings, publish the drawings 
of the active project to web and dwf, and zip the active 
project. Choose the Plot Project option from the 
drop-down to batch plot one or more drawings in the 
active project. The Plotting of drawings will be 
discussed in detail in Chapter 12.

Figure 2-28  The drop-down displayed 
on choosing the Publish/Plot button

Help
When you choose the Help button from the Project Manager, the AutoCAD 
Electrical 2013 - Help window will be displayed. Alternatively, choose Help from the 
Help menu to display the AutoCAD Electrical Help window. This window helps you 

understand different options, commands, and tools of AutoCAD Electrical.
 

Note
If you press F1 or use the HELP command, it will also display the AutoCAD Electrical Help 
window.        
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Project selection Drop-down List
The Project selection drop-down list is available at the top of the Project Manager, as shown 
in Figure 2-29, and it consists of the following options:

1.	 Names of all open projects                                             
2.	 Recent
3.	 New Project
4.	 Open Project

The active project is indicated by a check mark in the Project selection drop-down list, refer 
to Figure 2-29. You cannot close any open project using the Project selection drop-down list. 
The other options in this drop-down list are discussed next. 

Recent
When you select the Recent option from the Project 
selection drop-down list, the Recent Projects dialog 
box will be displayed. In this dialog box, you can view 
the recently opened projects, view the drawings of the 
selected project, remove the selected project, and find 
the drawings from the recent projects list displayed in 
the Recent Projects dialog box. 

Figure 2-29  The Project Manager 
displaying the Project selection 
drop-down list 

New Project
 Command:	 ACENEWPROJECT 

The New Project option is used to create a new project. 
To do so, select the New Project option from the Project 
selection drop-down list; the Create New Project dialog 
box will be displayed. The options in this dialog box 
have already been discussed. Specify the required options and choose the OK button; the new 
project will be created and will appear in bold text on the top of the list in the Projects rollout. 
Also, the newly created project will automatically become the active project.

Open Project
The Open Project option is used to open an existing project. To do so, select the Open 
Project option from the Project selection drop-down list; the Select Project File dialog box 
will be displayed. Next, select the project from this dialog box and choose the Open button; 
the selected project’s name will automatically be displayed in the Projects rollout in bold text 
and it will become the active project.

Open Project from Vault
The Open Project from Vault option is used to open a project from Autodesk Vault. Vault is 
a repository where documents and files are stored and managed.
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Projects Rollout
The Projects rollout displays a list of all opened 
projects. You can open as many projects as you 
want, but only one project can be active at a time. 
The active project appears in bold text and is always 
displayed at the top of the list in the Projects 
rollout. When you right-click on the name of the 
active project or on the project that is in bold text, 
a shortcut menu will be displayed, as shown in 
Figure 2-30. The options in the shortcut menu are 
discussed next.

Figure 2-30  The shortcut menu displayed 
by right-clicking on the active project in the 
Project Manager

Close
The Close option is used to remove the project 
which is displayed in the Projects rollout. 

Expand All
The Expand All option is used to expand a project 
and subfolder(s) in a project, if any. 

Collapse All
The Collapse All option is used to collapse a 
project and subfolder(s) in a project, if any.

Add Subfolder
The Add Subfolder option is used to add a subfolder in a project.

Flatten Structure 
The Flatten Structure option is used to remove subfolder(s) from the project to get a flat 
drawing list in a project. 

Descriptions
The Descriptions option is used to edit the description of an existing project. It is also used 
to add description to a new project. To do so, choose the Descriptions option from the 
shortcut menu; the Project Description dialog box will be displayed, refer to Figure 2-6.

As the Project Description dialog box displays unlimited lines, you can enter the description 
as per your requirement. The information that you enter in these lines can be re-used in the 
Component, Bill of Material, and Wire reports that are generated for the project or mapped to 
title block of the drawing. Select the in reports check box from the Project Description dialog 
box to include the project description line information in report headers and title blocks, 
which will be discussed in detail in the later chapters. 
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Title Block Update
 Command:	 WD_TB	

The Title Block Update option is used to update the information of the title block for the 
entire project drawing set or for the active drawing. To update the title block information, 
right-click on the active project; a shortcut menu is displayed. Choose the Title Block Update 
option from the shortcut menu; the Update Title Block dialog box will be displayed, as shown 
in Figure 2-31. The options in this dialog box will be discussed in detail in Chapter 12. You 
can also update a title block by using the WD_TB command.

Figure 2-31  The Update Title Block dialog box

Drawing List Report
 Command:	 WD_DWGLST_PROJ	

The Drawing List Report option is used to generate a report that lists the project drawing 
information of title block such as file names, file date, time, sheet number, drawing descriptions, 
sections, and so on. To generate a report, choose the Drawing List Report option from the 
shortcut menu or use the WD_DWGLST_PROJ command; the Drawing List Report dialog 
box will be displayed. The options in this dialog box are used to extract the new drawing list 
report, display previous drawing list report, and select format file for report. You will learn 
more about the generation of reports in Chapter 9.
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Task List 
The Task List option will be available only if an active project has pending updates on any 
drawing file, which is present within the active project and has been modified. Choose the 
Task List option from the shortcut menu; the Task List dialog box will be displayed. The 
options in the Task List dialog box will be discussed in Chapter 12.

Publish 
When you right-click on the active project 
and move the cursor to the Publish option of 
the shortcut menu, a cascading menu will 
be displayed, as shown in Figure 2-32. This 
cascading menu consists of Plot Project, 
Publish To WEB, Publish To DWF, and 
Zip Project. Choose the Plot Project option 
to batch plot one or more drawings in the 
active project. The Publish To WEB, Publish 
To DWF, and Zip Project options are used 
to publish the project to web, dwf, and to 
create the zipped file of a project, respectively.

Settings
When you choose the Settings option from the 
shortcut menu, the Current Settings dialog  
box is displayed. This dialog box displays 
settings of a project and information about 
AutoCAD Electrical environment.

Figure 2-32  Various Publish options displayed 
in the cascading menu

Exception List
When you choose the Exception List option from the shortcut menu, the Properties 
Exception List dialog box is displayed, as shown in Figure 2-33. This dialog box displays the 
list of drawing files that possess the properties  different from the project definition file 
(*.WDP). Figure 2-34 shows the Properties Exception List dialog box that will be displayed if 
the settings of all drawing files of a project match with the settings of the project definition 
file. Also, this dialog box displays that there are no exceptions. 

 
Note
You can view the difference between drawing properties and project defaults. To do so, choose 
the Settings Compare from the Projects menu or choose the Settings Compare button from 
the Drawing Properties drop-down of the ACE:Main Electrical 2 toolbar; the Compare 
Drawing and Project Settings dialog box will be displayed. This dialog box is used to compare 
the drawing and project default settings. 
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Figure 2-33  The Properties Exception List dialog box

Figure 2-34  The Properties Exception List dialog box 

Properties
On choosing the Properties option from the shortcut menu, the Project Properties dialog box 
will be displayed, as shown in Figure 2-35. You can use this dialog box to edit and modify 
the properties for project settings, components, wire numbers, cross-references, styles, and 
drawing format. The editing of project properties will be discussed in detail in Chapter 12.
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Figure 2-35  The Project Properties dialog box

Note
The options discussed above will be displayed if you right-click on an active project in the Projects 
rollout. But if you right-click on an inactive project, a shortcut menu with the Activate option 
will be displayed, as shown in Figure 2-36. If you choose this option from the shortcut menu, 
the selected project will become active and will be displayed at the top of the projects list in bold 
text. The active project is indicated by a tick mark in the Project selection drop-down list in 
the Project Manager.

          
Project Drawing List
The Project Drawing list displays the drawings available in a project. If you double-click on 
a project name in the Projects rollout of the Project Manager, the drawings associated with 
that project will be displayed. Right-click on a drawing file name; the editing options will be 
displayed, as shown in Figure 2-37. Using these options, you can open, close, remove, rename, 
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and replace a drawing file. You can also edit the properties of a drawing by choosing  Drawing 
Properties from the shortcut menu, refer to Figure 2-37. The options in this shortcut menu 
are discussed next.

Note
You can convert a drawing file into a reference drawing. To do so, right-click on the drawing 
name and choose Properties > Drawing Properties from the shortcut menu; the Drawing 
Properties dialog box will be displayed. Select the For Reference Only check box from the 
Drawing Settings tab; the drawing file will be converted to the reference drawing. However, 
its extension (.dwg) will remain the same. 

Figure 2-37  The editing options available 
in the shortcut menu 

Figure 2-36  The shortcut menu displaying 
the Activate option

Open
On choosing the Open option from the shortcut menu, the selected drawing will open in a 
new window and its name will appear in bold text in the Project Drawing list. Alternatively, 
you can select a drawing file name and press ENTER to open the corresponding drawing. 
You can also open a drawing file by double-clicking on it. The OPEN command is also used 
to open a drawing file.

Close
Choose the Close option from the shortcut menu to close the current drawing file. This option 
will be available only if the drawing file is open. You can also close a drawing file by using the 
CLOSE command.

Copy To
The Copy To option is used to copy the selected drawing to the same or another open project.  
To do so, choose the Copy To option from the shortcut menu; the Copy To dialog box will be 
displayed, as shown in Figure 2-38. Next, from the Save in drop-down list, select the location 
where you want to copy the drawings. If you want to change the name of the drawing file, 
enter the drawing file name in the File name edit box. Next, select the project name from 
the Project drop-down list. Choose the Save button; the Apply Project Defaults to Drawings 
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Settings message box will be displayed. Choose the Yes button in the message box to apply 
the project default values to the newly added drawing’s WD_M block definition; the selected 
drawing(s) will be copied to the specified project. If you want the new drawing to retain its 
existing settings, choose the No button. 

              

Figure 2-38  The Copy To dialog box

Remove 
Choose the Remove option from the shortcut menu to remove the selected drawing from the 
current project. This option does not remove the drawings permanently.

Replace
The Replace option is used to replace the selected drawing with the desired one. To do so, 
choose the Replace option from the shortcut menu; the Select Replacement Drawing dialog 
box will be displayed, as shown in Figure 2-39. Next, select the drawing file and choose the 
Select button; the Apply Project Defaults to Drawings Settings message box will be displayed, 
refer to Figure 2-9. Choose the Yes button to apply the project default values to the newly 
added drawing’s WD_M block definition. If you want the new drawing to retain its existing 
settings, choose the No button; the drawing file will get replaced with the selected drawings. 
This drawing will be displayed in the Project Drawing list. Also, note that if the drawing is 
already present in the project, it will display the message that drawing is already present in 
the project.
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Rename
The Rename option is used to rename the selected drawing. To do so, choose the Rename 
option from the Project Drawing list; the name of the selected drawing will be replaced by an 
edit box. Enter a new name in the edit box to rename the drawing. 

Figure 2-39  The Select Replacement Drawing dialog box

Drawing Properties
The Drawing Properties option is used to change the drawing settings, component tag 
format, wire number format, cross-reference format, styles, and drawing format. Also, you 
can edit, assign, and remove the section and sub-section codes of a drawing. To do so, choose 
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog 
box will be displayed. In the Drawing Properties dialog box, you can assign descriptions to 
the drawing files. Note that each individual drawing can have its own drawing settings for 
designing purpose. 

Apply Project Defaults
Choose the Apply Project Defaults option from the shortcut menu to apply the project 
default settings of the project to the new drawing files, if it was not done while creating the 
drawing files.

Copy
You can copy drawing settings and options from one drawing to one or more drawings by 
choosing the Copy option from the shortcut menu.
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Note
The drawing-specific information that is displayed in the Drawing Settings tab of the 
Drawing Properties dialog box cannot be copied from one drawing to another, refer to 
Figure 2-8.

Paste
Choose the Paste option from the shortcut menu to apply the copied drawing settings as well 
as other options from one drawing to other selected drawing(s). 

Settings Compare
The Settings Compare option is used to compare the drawing with its project settings. To 
do so, choose the Settings Compare option from the shortcut menu; the Compare Drawing 
and Project Settings dialog box will be displayed, as shown in Figure 2-40. This dialog box 
displays the differences between the drawing settings and their associated default values in 
the project definition file (.wdp). 

See Figure 2-40, where demo01.dwg is the drawing name and WDDEMO is the project 
name.

    

Figure 2-40  The Compare Drawing and Project Settings dialog box

Details/Preview Rollout
The Details/Preview rollout displays the details of the selected project or drawing as well as 
the preview of the selected drawing. The Details and Preview rollouts shown in Figure 2-41 
and Figure 2-42, respectively are discussed next.
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Figure 2-41  The Project Manager 
displaying the Details rollout

Figure 2-42  The Project Manager 
displaying the Preview rollout

Details
The Details button is used to view details of the selected project and drawing. To do 
so, select a project or drawing from the Projects rollout and then choose the Details 
button from the Details/Preview rollout in the Project Manager; details of the selected 

project or drawing will be displayed in the Details rollout. Whenever you select a drawing file, 
its details get updated and remain visible till you select a new drawing file. The information 
that will be displayed in the Details rollout includes status, description if added, file name, 
file location, file size, date when the file was last saved, the name of the user who modified 
the file last, and so on, refer to Figure 2-41. 

Note 
You can switch/move from one drawing to another by using the up and down arrow keys. 

Preview
The Preview button is used to display the preview of the selected drawing in the Preview 
rollout. To preview a selected drawing, select the drawing from the Projects rollout and 
then choose the Preview button from the Details/Preview rollout; the image of the 

selected drawing will be displayed in the Preview rollout, refer to Figure 2-42. The image of 
the selected drawing will be visible till you select another drawing from the Projects rollout. 
You can use up and down ARROW keys to view all drawings of a project.

Note
As discussed in the previous section, you can use the Project Manager to preview drawings. 
Moving between drawings by using the up and down ARROW keys does not open a drawing; 
it only changes the preview or the details displayed in the Project Manager.
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TUTORIALS
 Tutorial 1
In this tutorial, you will create a new project, add project description to it, refer to Figure 2-43. 
You will also create a new drawing in the project.   	                (Expected time: 10 min)

The following steps are required to complete this tutorial:

a.	 Create a new project.
b.	 Open the CADCIM project.
c.	 Create a new drawing and add description to it.
	
Creating a New Project
1.	 Start AutoCAD Electrical 2013 by choosing 

Start > All Programs (or Programs, if 
you are working with Windows XP Classic 
appearance mode) > Autodesk > AutoCAD 
Electrical 2013 > AutoCAD Electrical 2013. 
Alternatively, double-click on the shortcut 
icon of AutoCAD Electrical 2013 on the 
desktop of your computer to start AutoCAD 
Electrical 2013. 

2.	 The Project Manager is displayed by default 
on the left of the screen. If it is not displayed, 
choose the Manager tool from the Project 
Tools panel of the Project tab. Alternatively, 
choose the Project Manager tool from the 
ACE:Main Electrical 2 toolbar to display 
the Project Manager.

 
3.	 In the Project Manager, choose the New 

Project button; the Create New Project dialog 
box is displayed, as shown in Figure 2-44.

4.	 Enter CADCIM in the Name edit box.

Figure 2-43  The Project Manager displaying 
the CADCIM project and its description

5.	 To specify the location of the project, choose 
the Browse button; the Browse for Folder 
dialog box is displayed. By default, the Proj 
folder is selected in this dialog box. Choose 
the OK button; the location of the project is 
automatically displayed in the Location edit box.
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6.	 Select the Create Folder with Project Name check box, if it is not already selected.
            

Figure 2-44  The Create New Project dialog box

7.	 By default, the name and path of the existing project is displayed in the Copy Settings 
from Project File edit box which is c:\Users\User Name\Documents\AcadE 2013\Aedata\Proj\
Demo\wddemo.wdp. If it is not displayed, choose the Browse button; the Open dialog box 
is displayed. Select the Demo folder and then select the wddemo project file. Next, choose 
the Open button; the path and name of the existing project is displayed in the Copy 
Settings from Project File edit box.

8.	 Choose the Descriptions button from the Create New Project dialog box; the Project 
Description dialog box is displayed.

9.	 Enter the following information in the Project Description dialog box, as shown in 
Figure 2-45.

	 LINE1= CADCIM
	 LINE2= AutoCAD Electrical
	 LINE3= Sample Project
	 LINE4= 1
	 LINE5= 06/05/2012
	 LINE6= Sham
	 LINE7= John
	 LINE8= Crystal
	 LINE9= 1.00

	 Next, select the in reports check box corresponding to each of these lines to include this 
description in the reports, refer to Figure 2-45.
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Figure 2-45  The Project Description dialog box

10.	 Choose the OK button from the Project Description dialog box to save the changes made 
in this dialog box.

Note
The information that you enter in the description lines of the Project Description dialog box will 
be displayed at a particular location in the title block of the drawing, as shown in Figure 2-46. 
The title blocks will be discussed in detail in Chapter 12.

Figure 2-46  The title block showing the description entered in 
the Project Description dialog box

               

11.	 Choose the OK button from the Create New Project dialog box. You will notice that the 
CADCIM project appears in bold text at the top of the project list displayed in the Project 
Manager, refer to Figure 2-47.
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12.	 Next, select the CADCIM project from the Project Manager.

13.	 Choose the Details button from the Details/Preview rollout. You will notice that the project 
description/information entered in the first nine lines of the Project Description dialog 
box is displayed in the Details/Preview area, as shown in Figure 2-47.

Figure 2-47  The Project Manager displaying the 
CADCIM project and its description

Note
1. It is recommended to save all tutorials in the forthcoming chapters in the CADCIM 
project.

2. If the CADCIM project is not displayed in the Projects rollout of the Project Manager, select 
the Open Project option from the Project selection drop-down list; the Select Project File dialog 
box is displayed. Select the Proj folder from the Look in drop-down list and then double-click on 
the CADCIM folder name. Next, select the CADCIM file and choose the Open button; the 
CADCIM project is displayed in the Projects rollout and it becomes the active project.  

Creating a New Drawing
1.	 In the Project Manager, choose the New Drawing button; the Create New Drawing dialog 

box is displayed, as shown in Figure 2-48.
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Figure 2-48  The Create New Drawing dialog box

2.	 Enter C02_tut01 in the Name edit box.

3.	 To specify the template in the Template edit box, choose the Browse button; the Select 
template dialog box is displayed. In this dialog box, select ACAD_ELECTRICAL.dwt from 
the list displayed and then choose the Open button; the name and path of the template 
is displayed in the Template edit box. 

4.	 Clear the For Reference Only check box, if it is selected.

5.	 To specify the location for the drawing, choose the Browse button available on the right 
of the Location edit box; the Browse For Folder dialog box is displayed. By default, 
the CADCIM project is selected. Choose the OK button; the location of the drawing is 
automatically displayed in the Location edit box.

6.	 Enter 3 Phase Motors in the Description 1 edit box.

7.	 Enter Motor Control Circuit in the Description 2 edit box and enter 01 in the Drawing 
edit box in the Sheet Values area. 
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8.	 Choose the OK button from the Create New Drawing dialog box; you will notice that 
the drawing that you created gets added to the active project. To view the drawing that 
you created, double-click on the project name in the Project Manager; the drawing list is 
displayed and the drawing C02_tut01.dwg appears in bold text in the Project Manager. 
In this case, the active project is CADCIM; and therefore, the drawing gets added to this 
project. Click on the drawing; the details and the preview of the drawing are displayed in 
the Project Manager, as shown in Figures 2-49 and 2-50.

Figure 2-49  The Details rollout displaying    
the description of C02_tut01.dwg

Figure 2-50  The Preview area displaying 
the preview of C02_tut01.dwg

 Tutorial 2
In this tutorial, you will add and remove drawings from the CADCIM project and replace 
the drawings of the POINT2POINT project with the CADCIM project that you created in 
Tutorial 1 of this chapter. 					       (Expected time: 15 min)

	 The following steps are required to complete this tutorial:

a.	 Add drawings from the existing project to the CADCIM project.
b.	 Remove the drawing.
c.	 Replace the drawing.

Adding Drawings from the Existing Project
1.	 If the Project Manager is not displayed, choose the Manager tool from the Project Tools 

panel of the Project tab; the Project Manager is displayed.

2.	 To add drawings to the CADCIM project, right-click on it; a shortcut menu is displayed. 
Choose the Add Drawings option from the shortcut menu; the Select Files to Add 
dialog box is displayed. 
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3.	 Select the Proj folder from the Look in drop-down list; the list of all projects saved in this 
folder is displayed. Next, double-click on the Demo folder from the Select Files to Add 
dialog box; the drawings present in this folder are displayed.

Figure 2-51  The Project Manager displaying the 
CADCIM project with the drawings added to it

4.	 Press SHIFT/CTRL and select the 
DEMO01, DEMO02, DEMO03, DEMO04, 
and DEMO05 drawings.

5.	 Next, choose the Add button; the Apply 
Project Defaults to Drawing Settings 
message box is displayed.

6.	 Choose the Yes button from this message 
box; the selected drawings are added 
to the CADCIM project, as shown in 
Figure 2-51.

             
Removing the Drawing 
1.	 To remove the DEMO01.dwg drawing from the project, right-click on it and then choose the 

Remove option from the shortcut menu displayed; the DEMO01.dwg drawing is removed 
from the drawing list, see Figure 2-52.

Replacing the Drawing   
1.	 To replace the DEMO02.dwg drawing of the CADCIM project with the Connector.dwg of 

the POINT2POINT project, right-click on the DEMO02.dwg drawing; a shortcut menu is 
displayed. Choose the Replace option from the shortcut menu; the Select Replacement 
Drawing dialog box is displayed.

 
2.	 Next, select the Proj folder from the Look in drop-down list.

3.	 Double-click on the Point2Point folder; the Connector.dwg drawing is displayed in the 
Select Replacement Drawing dialog box

.
4.	 Next, select the Connector.dwg drawing and choose the Select button; the Apply Project 

Defaults to Drawing Settings message box is displayed.

5.	 Choose the Yes button; the DEMO02.dwg is replaced with the Connector.dwg drawing in 
the CADCIM project, as shown in Figure 2-53.
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Figure 2-52  The Project Manager displaying 
the CADCIM project after removing the 
DEMO01.dwg drawing 

Figure 2-53  The Project Manager displaying the 
CADCIM project with the DEMO02.dwg drawing 
replaced by the Connector.dwg drawing

DDF Tutorial 3 
In this tutorial, you will create a subfolder within a CADCIM project. You will also configure the 
drawing list display for the CADCIM project.                                 (Expected time : 15 min)

	 The following steps are required to complete this tutorial:

a.	 Create a subfolder.
b.	 Configure the drawing list display.

Creating a Subfolder
	 In this section, you will create a subfolder in the CADCIM project that is created 

in Tutorial 1.

1.	 Make sure that CADCIM project is activated 
in the Project Manager. Next, right-click on 
it; a shortcut menu is displayed.

2. 	 Choose the Add Subfolder option from the 
shortcut menu; a subfolder with the name 
NEW FOLDER is created within CADCIM 
project. Rename it as TUTORIALS.

3.	 Drag and drop the C02_tut01.dwg drawing 
created in Tutorial 1 on the TUTORIALS 
subfolder; the C02_tut01.dwg drawing is 
moved to the TUTORIALS subfolder, refer to 
Figure 2-54. 

Figure 2-54  The C02_tut01.dwg moved 
to the TUTORIALS subfolder
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Note 
1. In AutoCAD electrical, all projects and its subfolders names are displayed in upper case.

2. You can collapse the CADCIM project by right-clicking on its name and choosing Collapse 
All option from the shortcut menu displayed.

  

Configuring the Drawing List Display 
1.	 Choose the Drawing List Display Configuration button from the Project Manager; the 

Drawing List Display Configuration dialog box is displayed. You will notice that only 
File Name is displayed in the Current Display Order area.

2.	 Select Drawing Number(%D) from the Display Options area and then choose the >> 
button; Drawing Number(%D) is moved to the Current Display Order area.

3.	 Similarly, select Drawing Description 1 from the Display Options area and choose the 
>> button; Drawing Description 1 is moved to the Current Display Order area. Next, 
choose the OK button in the Drawing List Display Configuration dialog box.

	 You will notice that the drawing list display configuration is changed only for c02_tut01 
drawing and not for Connector.dwg, Demo003.dwg, Demo004.dwg, and Demo005.dwg 
in the CADCIM Project which are copied from the WDDEMO project. This is because,  
the description is not automatically transferred from one project to another. You need to 
copy the description using the project’s .wdp file.

Note 
You will learn more about .wdp file and the process to copy the description from one project to 
another in detail in Chapter 12.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 A project file is an ASCII text file. (T/F)

2.	 The Project Manager is used to manage the project files only. (T/F)

3.	 A project file always consists of drawings placed in a single directory. (T/F)

4.	 You can switch between sequential drawings in an active project. (T/F)

5.	 You can activate more than one project at a time. (T/F)

6.	 The  __________ option is used to plot all drawings of a project or a specified group of 
drawings.
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7.	 The  __________ option is used to create the copies of an existing project, including all 
drawing and project related files.

8.	 The __________ dialog box is used to edit the properties of a drawing.

9.	 Choose the __________ button to preview a selected drawing.

10.	 You can add up to __________ lines of description for each drawing in a project.

 Review Questions 
Answer the following questions:

1.	 Which of the following buttons in the Project Manager is used to execute the pending 
updates?

						    
		  (a) New Project				   (b) Refresh
		  (c) Project Task List	 		  (d) Surfer

2.	 Which of the following buttons is used to change the appearance of a drawing list displayed 
in the Project Manager?

		  (a) Plot Project				    (b) Project Task List
		  (c) Move Up				    (d) Drawing List Display Configuration

3.	 Which of the following options is used to add existing drawing(s) to a project?

		  (a) Descriptions			   (b) Add Active Drawing
		  (c) Add Drawings 	 		  (d) Title Block Update

4.	 Which of the following commands is used to update a title block?

		  (a) WD_TB				    (b) ACENAV
		  (c) AEDELETEPROJECT		  (d) ACENEWPROJECT

5.	 Which of the following dialog boxes is used to edit the project properties?

		  (a) Drawing List Display Configuration	
		  (b) Project Properties
		  (c) Drawing Properties			 
		  (d) Compare Drawing and Project Settings

6.	 The Remove Drawings option is used both for removing and deleting a drawing file. 
(T/F)

7.	 You can close only the non-active projects. (T/F)
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8.	 The check mark before a project name in the Project selection drop-down list indicates 
that the project is active. (T/F)

9.	 Projects can be closed by using the Project selection drop-down list. (T/F)

 Exercises 

 Exercise 1
Create a new project with the project name NEW_PROJECT and add appropriate description to 
it.					        	     		    (Expected time: 10 min)

Note
It is recommended to save all exercises in the forthcoming chapters in the NEW_PROJECT 
project.

	

 Exercise 2				       
Create a new drawing with the name C02_exer02.dwg in the project created in Exercise 1 and 
add appropriate description to it.				      (Expected time: 10 min) 

 Exercise 3
Using the Copy button, create a new project with the name  COPY_PROJECT containing 
the drawings and settings of any existing project.			    (Expected time: 10 min)

Answers to Self-Evaluation Test
1. T, 2. F, 3. F, 4. T, 5. F, 6. Plot Project, 7. Copy Project, 8. Drawing Properties, 9. Preview, 
10. three


